
Adobe Photoshop CC 2015:  
June update

Welcome to the latest Adobe Photoshop CC bulletin update. 
This is provided free to ensure everyone can be kept up-
to-date with the latest changes that have taken place in 
Photoshop.

This bulletin coincides with the announcement of 
Photoshop CC 2015 and content includes basic information 
about some of the latest features that are new to Photoshop 
in Photoshop CC 2015. The features described here will be 
accessible to all Creative Cloud subscribers and those who 
have purchased the current version of Photoshop CC. For a 
complete description of how to use these new Photoshop 
tools, with diagrams and step-by-step tools, I recommend 
you buy the Adobe Photoshop CC 2015 for Photographers 
book, which will be on sale later this summer.
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Image Adjustments as Smart Filters
This latest version of Photoshop CC allows you to apply 
most of the regular image adjustments from the Image ➯ 

Adjustments menu to smart object layers. Up until now it has 
only been possible to apply the Shadows/Highlights or HDR 
Toning adjustments to smart objects. Now, you can apply 
any of the adjustments in the Adjustments menu except 
for the Desaturate, Match Color, Replace Color or Equalize 
adjustments.
	 To create a smart object you can either go to the Filter menu 
and choose Convert for Smart Filters, or go the Layer menu 
and select Smart Object ➯ Convert to Smart Object.
	 The ability to apply a wide range of image adjustments 
to smart object layers is the same as when you apply an 
adjustment layer, but is like adding an adjustment layer in a 
clipping group with an associated layer mask. One advantage 
of this approach is that when you apply an image adjustment to 
a smart object layer and move that layer the image adjustment 
(or series of adjustments) are automatically moved with 
the layer. When working with adjustment layers you have to 
remember to select and move the adjustment layers at the 
same time as you do so. Overall, this means you now have 
the option to create smart objects and combine adding filters 
and image adjustments, which in turn can share the same 
filter mask. Of course, if you wanted to maintain separate 
masking control of the image adjustments then it may in these 
circumstances be better to stick to using adjustment layers. 
However, there is of course a workaround that was suggested 
by Julieanne Kost as a means to apply independent layer 
masking to nested Smart Objects. For example, if you convert a 
layer to a Smart Object and apply a filter or adjustment you can 
mask it, as shown in the example opposite. If you then select 
the Smart Object layer and choose Layer ➯ Smart Object ➯ 

Convert to Smart Object again, you can nest this Smart Object 
in another Smart Object. This effectively allows you to mask 
Smart Object adjustments independently.
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1 In this first step I opened a layered image in which the layer that contained the Spirit 
of St Louis airplane was a smart object layer. This meant that when this layer was 
selected I could go to the Image ➯ Adjustments menu and apply any of the main 
image adjustments from this menu. Here, I selected Curves.

2 This opened the Curves dialog, where I applied the adjustment shown here. This 
adjustment targeted the smart object layer contents only, which was effectively the 
same as applying an adjustment layer in a clipping group. This particular smart object 
layer was also masked by a layer mask. You will notice in the Properties panel that 
there are controls for fine-tuning the Filter mask as well as the layer mask (or vector 
mask if one was applied).
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Content-aware move with transformations
The following steps show how you can now apply transform 
adjustments as you carry out a content-aware move tool 
adjustment, whether you are using the Extend or Move mode.

1 To begin with I selected the content-aware move tool and clicked and dragged to 
define a rough outline of the guitar player. 

2 I added a new layer and checked ‘Sample All Layers’ and ‘Transform On Drop’ in the 
Options bar. I then clicked inside the selection with the content-aware move tool and 
dragged to the right. This created a temporary duplicate of the original selection.
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3 Because ‘Transform On Drop’ was checked I was able to scale the copied pixels and 
in this instance rotate slightly as well, making sure I matched the horizon line.

4 All I had to do next was to hit the E key to apply the transformation and instruct 
Photoshop to blend the transformed pixels with the underlying image and, at the same 
time, delete and fill the original pixel selection area. These edits were added to the 
new layer and I was also able to fine-tune the Structure and Color sliders to obtain 
the optimum blend. However, I did also need to carry out a little extra retouching to 
perfect the blending.
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Export options
Photoshop CC has new export options for RGB mode images. 
These are available via the File ➯ Export menu and also via the 
Layers panel. This feature allows you to export your documents, 
layers, or layer groups faster and with fewer steps.
	 First, I suggest you go to the Export preferences (Figure 1), 
where you can configure what happens when you choose an 
export option. The Quick Export Default section allows you to 
choose which format the files can be saved in when applying a 
quick export and whether transparent pixels are to be preserved 
or not. In the Export Location section you can either have the 
option to be asked where to save asset files each time, or to 
always export to an assets folder next to the current document.
	 When you choose File ➯ Export ➯ Quick Export as…, or go 
to the Layers panel menu and choose Quick Export as…, the 
assets saved will depend on what is selected in the document 
and whether Generator extended tagging has been utilized. 
In general, when you choose Quick Export, this exports a full 
resolution version of the image saved to the specified format. 
If a layer or layer group is targeted and extended tagging has 
been used in the naming, a full resolution version will get 
exported as well as one with the attributes specified using the 
Generator syntax. 

Figure 1 The Export preferences.
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Figure 2 The Export Preview dialog.
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	 If you want more control over the export process, choose 
File ➯ Save for  Web ➯ Export as… This opens the Export 
Preview dialog shown in Figure 2, where you have complete 
control over the file format selection, the file format settings, 
the image size you wish to scale the export to as well as the 
canvas size. As with Quick Export, the export location depends 
on the settings configured in the Export preferences.
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Noise panel for Blur Gallery filters
One of the problems you get when adding Blur Gallery effects 
to create the impression of shallow focus is that the blur effect 
will also blur the underlying noise structure of the image. Now, 
this is not such a problem if the image you are working on has 
no visible noise. But if you are editing a high ISO capture (like 
the example shown here), this is where the Noise panel can 
come in handy, because it allows you to generate noise that 
can be added just to the blurred areas.
	 When working with any of the Blur Gallery filters you 
simply go to the Noise panel. If the noise panel is not visible, 
choose Reset Blur Gallery from the workspace menu in the 
Options bar. You can then check to add noise, select a noise 
method from the top menu (Gaussian, Uniform or Grain) and 
adjust the Amount slider to determine how much noise is 
added. In Grain mode, the controls are the same as those 
found in the Camera Raw Effects panel and you can adjust 
the Size and Randomness sliders. The Color slider controls 
the monochrome to color ratio (this can help you match the 
appearance of color noise present in the underlying image). 
Lastly, there is the Highlights slider. This can be used to reduce 
the noise in the highlight areas to achieve better highlight/
shadow matching.

Figure 3 This shows a close-up view of the 
image shown here where the top view shows 
the outcome with no noise added and below 
where grain noise was added to the Blur 
Gallery effect.1 This photograph was shot using the Canon EOS 550D at 6400 ISO. As one might 

expect, there is a fair amount of luminance and color noise visible in this image. It can 
be treated to some extent using the Detail panel, but not completely. 

No noise

Noise added to blur effect
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2 I went to the Filter menu and chose Blur Gallery ➯ Iris Blur. I manipulated the iris 
shape to achieve the desired shape and applied a 35 pixel blur. However, the blur 
effect also blurred the underlying grain in the image.

3 To correct this, I enabled noise in the Noise panel, set the mode to ‘Grain’ (circled) 
and adjusted the Amount slider to add more noise, adjusting the Size and Roughness. 
I then went to the Color slider and set this to 15% to make the added noise less 
monochrome. With the Highlights slider I left this set to 100%. Basically, these 
controls allow you to kind of mimic the appearance of the underlying grain in the 
photograph.
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Photomerge refinements
While Camera Raw now now incorporates a panorama DNG creation func-

tion, the Photomerge dialog in Photoshop hs been updated to allow you to 

include a content-aware fill step to fill the transparent areas.

1 Here, I chose FIle ➯ Automate ➯ Photomerge, selected the photos shown here, 
set the Layout mode to Cylindrical and checked all the boxes at the bottom, including 
‘Content Aware Fill Transparent Areas’.

2 This generated the panorama stitch image shown here, where you will notice becuse 
I checked the new option this added a merged layer with a content-aware fill applied to 
the outer transparent pixels.
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Image Processor Pro
The Image Processor Pro (Figure 4) is now made available as 
a separate downloadable script, which can be downloaded 
via the Adobe website. Once downloaded and installed, you 
will then need to go to the File ➯ Scripts menu and select 
Browse… to launch Image Processor Pro. Meanwhile, the 
original Image Processor can also be accessed via the File 
➯ Scripts menu in Photoshop, or via the Tools ➯ Photoshop 
menu in Bridge. Image Processor Pro though allows you to 
select a folder of images (or select all open images) to process, 
and select a location to save the processed files to. Image 
Processor Pro can then be configured to run a Photoshop 
action (if required) and save the processed files using a wide 
variety of file formats and simultaneously process to save the 
files in multiple file formats to separate folders. This can be 
very handy if you wish to produce, say, both a TIFF version at 
high resolution and a JPEG version ready to place in a web 
page layout.
	 With the standard Image Processor, you had the option 
to simultaneously save a JPEG, PSD and TIFF version and 
determine the output dimensions for each, but that was all. The 
more advanced controls in Image Processor Pro now allow you 
to configure sets of file outputs and apply individual processing 
instructions to each set. For instance, in Figure 4 you can see 
that Set 1 is configured to save a JPEG version, and there are 
options to determine the pixel dimensions, resolution and 
image quality. Furthermore, you can choose the output profile 
and select Photoshop actions to run either before or after 
image resizing. Meanwhile, Set 2 is configured for saving TIFF 
file versions. Here, you can also choose different file format 
options, resize the image and select the desired bit depth. With 
the PSD set there are options to include alpha channels, layers 
and whether you want to maximize file compatibility. Below 
the file format options is the File Naming section, where you 
can determine how the files are renamed for each individual 
set. The options here are similar to those found in the Batch 
processing and Create Droplet dialogs.
	 Lastly, there are plus and minus buttons you can use 
to add or remove sets. For example, you could configure 
Image Processor Pro to output three different types of JPEG 
output. Maybe, one set of JPEGs resized for sending as email 
attachments, others saved ready for placement in a website 
and others as full -size images for placement in a layout. Once 

Preparing JPEGs for the Web
When you are preparing images that 
are destined to be shared by email 
or published via the Web, the Image 
Processor is a handy tool to use because 
you can not only resize the images as 
part of the image processing, but you can 
instruct the Image Processor to convert 
the image from its current profile space 
to sRGB, which is the ideal RGB space for 
general purpose Web viewing.
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Figure 4 This shows Image Processor Pro, which can be configured to process 
single or multiple images, apply Photoshop actions, add copyright info and save the 
files to a designated folder location in one or more of the following file formats: JPEG, 
PSD or TIFF. The destination folder will contain the processed images and these will 
be separated into folders named according to the file formats selected. 

the settings have been configured you can click on the Save… 
button at the top to save as a configuration setting that can be 
opened via the Load… button.
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Figure 5  The Adobe Color Themes panel.

Adobe Color Themes panel
The Adobe Color Themes panel (Figure 5) restores Kuler 
functionality to Photoshop. Kuler was removed when Photoshop 
CC was first released due to the removal of Flash support from 
Photoshop. This panel provides the same level of functionality 
allowing users to explore lots of different color combination 
themes as well as create their own custom themes.

Setting a custom background color
In the New Document dialog the Background Content menu 
now features an Other… option. When this is selected it opens 
the Color picker, which allows you to select a custom color as 
the background color (see Figure 6). 

Figure 6  The New Document dialog, showing the Other… background color option.


